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About This Training Workbook

This training workbook is for new users of the Mentor Graphics QuickSim II logic 
simulator. This workbook introduces you to the components of QuickSim II, and 
it provides information about and practice using the SimView User Interface and 
Design Manager applications.

If you are using this document online in INFORM, you will see occasional 
highlighted text. On a black and white display, this text appears enclosed in a 
rectangle, and on a color display using the default color map, the text is blue. The 
highlighted text is a hypertext link to related materials in this and other 
documents. If you click the Select mouse button on a hypertext link, the linked 
location will be displayed. For more information on hypertext links in online 
manuals, refer to the section “Navigating Online Documents” in the BOLD 
Browser User's Manual.

i For information about the documentation conventions used in this 
manual, refer to Mentor Graphics Corporation Documentation 
Conventions.
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Objectives
After reading this training workbook and completing the labs, you should be able 
to do the following:

• Invoke the QuickSim II application

• Perform a basic simulation

• Set up the QuickSim II simulator

• Apply stimulus

• Run and reset the simulation

• Make design modifications

• Compare results

Workbook Organization
This training workbook consists of the following sections:

• Module 1, “Introducing QuickSim II,“ which provides a basic discussion of 
QuickSim II in the Mentor Graphics environment

• Module 2, “Some Basic Concepts,“ which describes some features of the 
QuickSim II simulation environment

• Module 3, “Lab Exercises,“ which allows you to practice tasks identified in the 
“Some Basic Concepts" section

• Module 4, “For Continued Learning...“ which lists the training products 
available from Mentor Graphics

• Appendix A, “Definitions,“ which defines some basic terms
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Notational Conventions
The lab exercise section of this workbook asks you to choose menu items in order 
to issue commands.

In the menu bar of the session window, the term “Menu” corresponds to the 
pulldown menu name. In the edit area of the application window, “Menu” 
corresponds to the popup menu in the edit area. The term “Item” can be the end of 
the menu path, or it can be the name of another menu. If “Item” refers to another 
menu, it is followed by an arrow. Each time you move the cursor to an arrow, 
another menu cascades to the right. For example, Figure 1 shows the MGC 
Notepad cascading menu.

Notepad

Cleanup Windows

Userware

Transcript

Setup

Design Management

Location Map

Print Screen:

New

Open

Set Default Font

Figure 1. MGC Notepad Cascading Menu

In Figure 1, the menu path is represented by the following notation:

(Menu Bar) > MGC > Notepad > New

To travel the menu path, you press and hold the Select mouse button on the MGC 
menu in the menu bar, slide the cursor to the arrow following Notepad, slide the 
cursor over New, and then release the Select mouse button.
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Page Layout
The “Some Basic Concepts“section of this training workbook presents concepts 
about the QuickSim II application. Each concept is presented on two facing pages, 
as shown in Figure 2. The left-facing page contains an illustration or bulleted list 
that summarizes the explanatory material on the right-facing page. When your 
book is open to a concept, you can see all of the information at once.

Explanatory Text
and References

Title, Pictures
and Bulleted List

Mouse Buttons
The three-button mouse has a left,
middle, and right button.
Mentor Graphics manuals refer to the
mouse buttons by the
following names:

The            mouse button is the left button.Select

The                      mouse button is the
center button.

Stroke/Drag

The           mouse button is the right button.Menu

The Three-Button Mouse
The three-button mouse is the most common
graphic input device. You interact with
an application by moving the mouse and
manipulating the mouse buttons. The mouse
actions affect what is displayed on the
screen and how the application operates.
Each button has a standard Mentor Graphics
name and predefined function.

The Mouse

The Three-Button Mouse

Mouse Buttons

For more information on using the
mouse, refer to page 3-23.

Menu

Stroke/Drag

Select

i

Figure 2. Page Layout

If you are learning this material in an instructor-led workshop, your instructor 
might present the left-hand pages as overhead transparencies. You can follow 
along in your workbook as the instructor teaches you the underlying concepts. If 
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your learning program is self-directed, you can proceed through the material by 
reading each discussion with both pages viewed.

Additionally, the “Overview of QuickSim II” and “Key Concepts” chapters of the 
QuickSim II User's Manual are recommended prerequisite reading for this 
training workbook because the “Some Basic Concepts” module of this workbook 
covers only some of the concepts discussed in the QuickSim II User's Manual. 

Learning Programs
Getting Started with QuickSim II is part of a series of training workbooks and 
learning programs. Getting Started with Falcon Framework and Getting Started 
with Design Architect are recommended prerequisites to this workbook.

i For information about Getting Started workbooks, Personal 
Learning Programs, and Instructor-Led Workshops, refer to the section 
Related Publications and Module 4, For Continued Learning....

Related Publications
The following Mentor Graphics manuals contain important information on related 
topics.

Getting Started Training Workbooks

All Getting Started workbooks provide conceptual information about the product 
and lab exercises that you can follow to gain hands-on experience with the 
product.

Getting Started with Falcon Framework is for new users of the Mentor Graphics 
Falcon Framework. This workbook introduces you to the components of the 
Falcon Framework and provides information about and practice using the 
Common User Interface, Design Manager, INFORM, Notepad, and Decision 
Support System applications.
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Getting Started with Design Architect is for new users of Design Architect who 
have some knowledge about schematic drawing and electronic design, and are 
familiar with the UNIX or Aegis environment. The training workbook provides 
you with basic instructions on how to use Design Architect to create schematics 
and symbols.

Getting Started with QuickSim II is for electrical engineers who have not 
previously used QuickSim II. The training workbook provides you with basic 
instructions on how to use QuickSim II to simulate digital designs.

Getting Started with System-1076 contains information about creating, modeling, 
and debugging hardware designs with Mentor Graphics System-1076. System-
1076 allows system and component designers to create language models of their 
systems or chips. System-1076 is based on IEEE Std 1076-1987, IEEE Standard 
VHDL Language Reference Manual.

User's Manuals

Common User Interface Manual describes how to use the user interface features 
that are common to all Mentor Graphics products. This manual tells how to 
manage and use windows, the popup command line, function keys, strokes, 
menus, prompt bars, and dialog boxes.

QuickSim II User's Manual describes how to use the QuickSim II logic simulator. 
This manual provides background information, a hands-on tutorial intended for 
new users, various simulation procedures, and a comprehensive list of related 
procedures.

SimView Common Simulation User's Manual describes how to use the SimView 
application. This manual provides background information, various simulation 
procedures, and a comprehensive list of related procedures that are common to all 
Mentor Graphics digital and analog analysis applications.

Design Manager User's Manual provides information about the concepts and use 
of the Design Manager. This manual contains a basic overview of design 
management and of the Design Manager, key concepts to help you use the Design 
Manager, and many design management procedures.
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BOLD Browser User's Manual describes the BOLD Browser and covers basic 
operations, such as locating and viewing online information.

Reference and Programming Manuals

Common User Interface Reference Manual contains information about all of the 
Common User Interface functions.

Customizing the Common User Interface describes how to extend the Common 
User Interface. This manual explains how to redefine keys and how to create your 
own menus, windows, dialog boxes, messages, and palettes.

SimView Common Simulation Reference Manual contains information about the 
commands, functions, userware, and related reference material for the SimView 
application. This material is also common to all Mentor Graphics digital and 
analog analysis applications.

Design Manager Reference Manual describes the AMPLE functions that are 
available in the Design Manager. This manual also describes the Design Manager 
shell commands.

Digital Simulators Reference Manual contains information about the commands, 
functions, userware, and related reference material specific to the Mentor 
Graphics digital analysis applications.
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Module 1
Introducing QuickSim II

Objectives
Upon completion of this section, you should be able to:

• Describe QuickSim II Within the Mentor Graphics Tool Set

• List the types of models that can be used with QuickSim II

• Describe The Capture and Simulation Process and how QuickSim II can help 
you with this process

• Describe the QuickSim II Architecture

• List the QuickSim II Input and Output used by the application
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QuickSim II Within the Mentor Graphics 
Tool Set

• Simulates a digital schematic design from Design 
Architect

• Allows you to use hardware models, System-1076 
VHDL models, and component models

• Provides an iterative process through schematic 
capture, simulation, physical layout, and test
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QuickSim II Within the Mentor Graphics 
Tool Set

The QuickSim II application is a logic simulator that enables you to test the 
“software breadboard” of a digital hardware design. QuickSim II performs 
operations on the software schematic of a digital logic schematic design created in 
Design Architect, or in synthesis or VHDL applications. The schematic design 
consists of parts connected together in Design Architect.

You can use the following modeling systems in conjunction with QuickSim II:

• Hardware. The LM-Family of models are hardware models in the Mentor 
Graphics tool set that you can use in order to model digital hardware.

• Architectural. System-1076 is a method by which a hardware designer can 
create, debug, and simulate System-1076 models with an integrated set of 
tools.

• Component. Behavioral Language Models (BLMs), QuickParts, and Sheet-
based parts are component-level software models in the Mentor Graphics tool 
set that you can use to model digital logic devices.

After verifying the functional accuracy of a digital logic schematic design by 
simulating in QuickSim II, you can use physical layout applications to place and 
route the printed circuit board design or to layout an ASIC. You can then use test 
applications to evaluate the testability of the design.

At any point, you can reiterate the process by making design changes and 
verifying the functionality of the design through more simulation, layout, and test 
procedures.



Getting Started with QuickSim II, V8.5_11-4

Introducing QuickSim II

November 1995

The Capture and Simulation Process

Verify System
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The Capture and Simulation Process
The QuickSim II Capture and Simulation Process is iterative, and you can repeat 
the applications until you feel confident about your design. A single iteration of 
the process typically includes these major steps:

• Capture the schematic. Create a component using Design Architect to capture 
the schematic and edit symbols.

• Create a design viewpoint. Optionally, create a design viewpoint in the Design 
Viewpoint Editor (DVE). A design viewpoint contains configuration rules that 
determine how QuickSim II evaluates the contents of the design.

• Calculate delay values. Optionally, invoke TimeBase to calculate delay 
values from the information provided in technology files.

• Invoke SimView. Optionally, invoke SimView to create stimulus waveforms 
for subsequent simulation in QuickSim II.

• Invoke the simulator. Invoke QuickSim II on the design. Specify the design 
viewpoint if a custom one exists. By default, QuickSim II creates a default 
design viewpoint configuration when it invokes.

• Set up the simulation. Specify setup conditions such as the timing, spike 
handling model, and runtime checking capabilities. Your design's maturity 
determines the setup conditions. During early design stages, you focus on 
debugging logic functionality, so you should enable the unit delay timing 
mode. The effects of timing becomes the next concern, so you include timing 
information. Later, your design might be one or more instances in a larger 
system, where you can again use unit delay for performance reasons.

• Create or refine stimulus and run the simulation.

• Analyze simulation results. Optionally, you can exit QuickSim II and use 
SimView to analyze the simulation data.

• Modify design and rerun the simulation. You can correct design errors in 
the Design Architect or perform “what if” analyses by modifying design 
property values. For example, you can change the schematic using Design 
Architect and then bring those changes directly into the simulator during the 
simulation session.
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QuickSim II Architecture

• Communication between QuickSim II and the user, 
the waveform databases, and the Electronic 
Design Database
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QuickSim II Architecture
The QuickSim II architecture consists of the following elements:

• Front end. Software that provides communication between the user, the 
design data, and the QuickSim II kernel

• QuickSim II Userware. Menus, key definitions, session windows, and 
gadgets that enhance the usability of the simulator

• SimView. Simulator commands that enable you to interact with a 
simulation and to display the results for analysis

• DVAS (Design Viewing and Analysis Support). Commands common to 
many applications that enable you to select and to view design items

• DVE (Design Viewpoint Editor). An application containing commands 
that enable you to perform incremental design changes during the 
simulation

• SC (Syntax Checker). A utility that allows you to check the hierarchical 
design connectivity during a simulation; useful after making incremental 
design changes

• Electronic Design Database. Design structure, design viewpoint, back 
annotations, and other design objects that the simulator uses; provides 
information to both the front-end and the kernel

• QuickSim II kernel. Program that performs the actual simulation

• Waveform Databases (WDBs). Collections of objects that provide stimulus 
to the design and hold simulation results; results database generated by the 
kernel and accessed by the front-end for display purposes
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QuickSim II Input and Output
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QuickSim II Input and Output
Input and output objects include the following:

• Input objects

o Models. Primitives, QuickPart Schematics, QuickPart Tables, Memory 
Table Models, System-1076 VHDL, LM-Family, and BLMs

o Timing objects. Technology files and linear technology files

o Keyboard, mouse. Interactive devices for QuickSim II and the database

• Output objects

o List and Trace. Window information can be sent to file or printer

o Reports. Report information can be sent to file or printer

o Display. Visual interactive device for QuickSim II and the database

• Input/Output objects

o Waveform Databases. Stimulus from converted forcefile and logfile 
formats; can convert to logfile and forcefile formats

o Design Viewpoint. Configuration data, design checking rules, back 
annotation object

o Pictures. Graphics loaded, viewed, updated, and saved

o Modelfiles. RAM and ROM initialization information; simulator can write 
RAM/ROM simulation data to a file; also for PLAs and PLDs

o Setup object. Setup conditions for simulation interface and kernel

o Save state object. Saved and restored information for simulation states
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Module 2
Some Basic Concepts

Introduction
This section contains some basic concepts for the QuickSim II application. The 
topics covered in this section are:

• Definition of An Electronic Design

• A basic review of Models and Properties

• What Design Changes can be done

• Definitions of Logic Values and Drive Strengths

• What Timing Modes are available

• How the Waveform Databases (WDBs) are set up

• How Forces are applied

• How Simulation Resetting is performed

• A review of the QuickSim II Session Window and an introduction to basic 
QuickSim II windows, including:
> Schematic Window
> List Window
> Trace Window
> Monitor Window
> Waveform DBs Window and Waveform Window

• A review of QuickSim II Palettes, and QuickSim II Pulldown Menus and 
QuickSim II Popup Menus
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Objectives

• Describe the two parts of an electronic design

• Describe the two types of models

• Define a property; list the four property attributes

• Describe design change methods

• Define the logic values and drive strengths 
associated with the twelve signal states

• Describe the three timing modes

• Describe the major session window areas

• Describe the contents of these windows: 
schematic view, List, Trace, Monitor, Transcript, 
Waveform

• Describe palettes and pulldown and popup menus
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Objectives
Upon completion of this section, you should be able to:

• Define an electronic design and describe its two major parts

• Define a model and describe the two types of models

• Define a property and list the four attributes of a property

• List and describe methods of making design changes

• Define the logic values and the drive strengths that combine to make up the 
twelve signal states

• List and describe the three timing modes

• Describe the major areas of the QuickSim II session window

• Describe the contents of each of the following: schematic view window, List 
window, Trace window, Monitor window, Transcript window, and Waveform 
window

• Describe the sections in a palette

• Describe the differences between pulldown and popup menus
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An Electronic Design

• An electronic design consists of two elements:

o Component

o Design viewpoint

• Both elements are required for analysis and layout
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An Electronic Design
An electronic design is an object that represents the circuitry of an electronic 
device and must have both a component and a design viewpoint. Components and 
design viewpoints are defined as follows:

• Component. An object that is created by the design creation applications; 
contains a set of models that describe the functional, graphical, timing, and 
technological aspects of the electronic design.

A component can be a logic gate, for example, or it can be a schematic for an 
entire system.

• Design viewpoint. An object that contains specific interpretations of a 
component for different Mentor Graphics applications; created by invoking an 
application on a design or by using the Design Viewpoint Editor.

A design viewpoint contains a configuration that defines how a component is 
interpreted by a particular application. For example, a viewpoint can contain a 
configuration for QuickSim II and a configuration for PCB Package.

i For more information about design viewpoints, refer to the Design 
Viewpoint Editor User's and Reference Manual.
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Models and Properties

• Models define functional, timing, and graphical 
aspects of a component

• Examples of model types are:

o Symbol

o Schematic

o VHDL

o Technology file

• Properties are labels attached to a design object

• Properties are needed to:

o Establish connectivity

o Convey circuit characteristics to the simulator

• Properties have these attributes:

o Name

o Type

o Value

o Owner
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Models and Properties
An electronic design uses models and properties to provide functional and timing 
information during a simulation and to define design characteristics that cannot be 
visually identified from a schematic design. Models and properties are defined as:

• Model. A description of a device that provides functional and timing 
information; used by simulation and analysis applications.

• Property. A textual label attached to a design object that defines design 
characteristics; an example is a rise property.

A model can be either functional or non-functional, which are defined as follows:

• Functional. A model that describes the function of a circuit; examples are a 
built-in primitive, a QuickPart Table, a QuickPart Schematic, a VHDL model, 
or a Behavioral Language Model (BLM).

• Non-functional. A model that does not describe the function of a circuit; 
examples are symbols and technology files.

A property conveys circuit characteristics, such as pin rise and fall times, 
initialization states of pins and nets, or logic functions associated with symbols. 
Properties have at least three attributes: name, type, and value. Properties can also 
have an owner attribute.

i For more information about modeling techniques, refer to the Digital 
Modeling Guide. For more information about properties used in 
QuickSim II, refer to the “Simulation Design Properties” subsection of 
the Digital Simulators Reference Manual. 
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Design Changes

• Decrease design iteration time

• Can be made within the QuickSim II environment

• Are of three types:

o Reloading models

o Swapping models

o Changing design properties

• Are tracked by the simulator

o Property changes go into back annotation 
object

o Model changes tracked internally
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Design Changes
An incremental design change is a change to a design object that is incorporated in 
the design without exiting the QuickSim II application environment. Incremental 
design changes in QuickSim II usually decrease the time needed for a design 
iteration. The three types of design changes are as follows:

• Reloading models. If a model changes during the time you are in a 
QuickSim II session, you can reload the most recent version.

For example, you can use the appropriate editor to correct a problem with a 
schematic or a technology file. You can then recompile the file, if necessary, 
and reload the corrected version from within the simulation environment.

• Swapping models. If you want to substitute one compatible model for another, 
you can swap the models by editing the Model property.

For example, you can swap a sheet-based model for a VHDL model by 
changing the Model property.

• Changing design properties. If you want to add or change property values in 
a design, you can annotate the design directly in the QuickSim II simulator. 
Annotating a design with new or different property values enables you to 
perform “what if” scenarios.

For example, you can adjust delays by changing the values of the Rise and Fall 
properties. You can also change properties that affect design parameters.

i For more information about design changes, refer to the “Design 
Changes in QuickSim II” section in the QuickSim II User's Manual.
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Logic Values and Drive Strengths

• Twelve signal states in QuickSim II

• Signal states: combinations of logic values and 
drive strengths

• Logic values: high (1), low (0), and unknown (X)

• Drive strengths: strong (S), resistive (R), high 
impedance (Z), and indeterminate (I)

Signal Level

Drive Strength Low (0) High (1) Unknown (X)

Strong (S) 0S 1S XS

Resistive (R) 0R 1R XR

High Impedance (Z) 0Z 1Z XZ

Indeterminate (I) 0I 1I XI
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Logic Values and Drive Strengths
There are twelve signal states in the QuickSim II environment. Each signal state is 
a combination of a logic value and a drive strength. A logic value and a drive 
strength are defined as follows:

• Logic value. A Boolean value that indicates the level of a signal. The logic 
values are:

0.  A low signal level

1.  A high signal level

X.  An unknown signal level

• Drive strength. A value that allows the simulator to resolve signal contention 
and to simulate effects of different technologies. The drive strengths are:

S.  A strong signal strength

R.  A resistive signal strength

Z.  A high impedance signal strength

I.  An indeterminate signal strength

i For more information about signal states and state-strength accuracy, 
refer to the “QuickSim II Logic Values and Drive Strengths” and the 
“Simulator Accuracy” subsections of the QuickSim II User's Manual.
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Timing Modes

• Five timing modes

o Unit delay

o Linear timing, if present (lmin, ltyp, or lmax)

o Linear timing with constraint checking

o Full timing (min, typ, or max)

o Full timing with constraint checking

• Timing mode set at invoke for entire design; 
during simulation for specific instances

Simulation Accuracy
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n
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Unit
Delay

Linear
Timing
(if present)

Full Timing

Linear
Timing with
Constraint
Checking

Full Timing
with
Constraint
Checking
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Timing Modes
Each mode consists of settings that make simulation speed and accuracy trade-
offs. You can set the mode for the design when you invoke, or you can use 
individual commands on individual instances. The timing modes are as follows:

• Unit delay. (Default) Provides high performance at the expense of accuracy. 
You can use this mode when debugging design functionality. All output and 
I/O pins have a rise and fall delay of one timestep (default is 0.1 ns). Input pins 
have a rise and fall delay of 0. The simulator ignores all technology files.

• Linear timing (lmin, ltyp, or lmax). Provides straight-line approximations of 
the timing that is defined by the associated technology files. In this mode, you 
can debug the effects of timing on your design's functionality, but only if the 
components include linear technology files. In this mode, timing is computed 
significantly faster than when you use full technology files.

• Linear timing with constraint checking. Provides straight-line timing 
approximations with full constraint checking. You can use this mode to 
produce timing violation messages. As with the linear timing mode, your 
components must provide linear technology files. The next step is to use full 
timing with constraint checking.

• Full timing. Provides timing accuracy without timing constraint checking. 
This mode simulates the effects of timing on the design logic. Full timing 
consists of the min, typ, or max values from all technology file-specified delay 
equations, rise and fall pin delays, and BLM and VHDL delay instructions.

• Full timing with constraint checking. Provides complete timing accuracy 
with full constraint checking. You can use this timing mode to produce timing 
violation messages during full-circuit debugging operations. This mode uses 
the min, typ, or max values from all technology file-specified delay equations, 
rise and fall pin delays, and BLM and VHDL delay instructions; it also checks 
for constraints and spike, contention, and hazard violations.

i For more information about timing modes, refer to subsection 
“Simulation Timing Modes” of the QuickSim II User's Manual.
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Waveform Databases (WDBs)

• Are used to store stimulus and/or results from a 
simulation

SimView
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connect
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Waveform Databases (WDBs)
A waveform database (WDB) is a design object that contains signal activity in a 
binary (compiled) format. The simulator directly interacts with WDBs when it 
either reads stimulus or writes results. WDBs have the following characteristics:

• You can create WDBs to view and to use as stimulus.

• You can save WDBs to disk, and manage them by version.

• The simulator can quickly read and apply WDBs to designs.

• The simulator automatically creates and manages the following WDBs:

o Results WDB. Stores the simulated activity of the targeted signals; 
provides signal data for window displays (by default).

o Forces WDB. Contains the waveforms that were created or modified by the 
Force (or the Delete Force) command. By default, you can use the 
Waveform Editor to edit waveforms in the Forces WDB.

o Stimulus WDB. Merges all the connected waveforms and supplies them to 
the kernel as a single stream of stimulus. You can connect to the kernel any 
user-defined WDB. The Forces WDB is connected by default.

• You can load a WDB from disk into the Forces WDB to be used as stimulus.

i For more information about WDBs, refer to subsection “Waveform 
Databases” in the SimView Common Simulation User's Manual.
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Forces

• Individual stimulus applied to:

o Pins

o Nets

o Buses

•  Stored in Forces waveform database (WDB) by 
default; you can target forces to any WDB

• Connected to Stimulus WDB by default when 
simulator is invoked

• Can be disconnected from Stimulus WDB
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Forces
A force is an individual stimulus that is applied to a pin, net, or bus.

When you invoke QuickSim II on a design, the Forces WDB is automatically 
connected to the Stimulus WDB. All the forces in the Forces WDB are applied to 
any simulation that the QuickSim II simulator performs. You can connect 
multiple WDBs to the Stimulus WDB.

If you do not want the forces in the Forces WDB to be applied to a simulation, you 
can disconnect the entire Forces WDB, which effectively cancels all individual 
forces that have been made up to that point. You disconnect the Forces WDB by 
responding to the dialog box that appears when you choose the (Menu Bar) > 
Setup > Disconnect > Waveform DBs pulldown menu path.

You can also disconnect individual forces on a specific signal by indicating one or 
more forces in a dialog box that appears in response to the (Menu Bar) > 
Setup > Disconnect > Waveforms pulldown menu path.

You can reconnect the Forces WDB or an individual force by choosing the 
Connect pulldown menu paths similar to the Disconnect menu paths above.

i For more information about forces, refer to subsection “Creating 
Stimulus” subsection of the SimView Common Simulation User's 
Manual.
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Simulation Resetting

• You can reset parts of a simulation:

o State

o Setup

• You can save result waveform database also.

• You can use a dialog box to choose options.

Reset

OK Reset

State

Save 'results' Waveform DB

Setup

This option will reset the current simulation
time back to zero and clear the 'results'
Waveform DB.

Viewpoint

Pathname Navigator...

Replace

Cancel

Do NOT reset Waveform DBs
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Simulation Resetting
Resetting a simulation is a method that enables you to start a simulation again at a 
time domain of zero or to reinstate the setup conditions for SimView and/or 
QuickSim II that were in effect when you invoked the simulator.

You can use any or all of the following choices to reset a simulation:  

• State. An option that resets the simulation time to zero. No other conditions 
that previously existed are reinstated; stimulus are maintained, but the data in 
the Results Waveform Database (WDB) is removed. The Reset dialog box 
provides you a chance to save the Results WDB.

• Setup. Reinstates the setup conditions that were in effect when you invoked 
the simulator. Resetting setup conditions closes all windows (except the 
session window), deletes action lists and expression definitions, and resets all 
bus definitions, synonyms (probes), groups, and selection filters to their 
original settings.

Other setup conditions include timing and delay modes, checking modes and 
settings, keep list, run setup, and the list of breakpoint settings.

You can access the Reset dialog box by following the Run > Reset... pulldown 
menu path or the Reset palette button.

i For more information about resetting a simulation, refer to the 
“Resetting the Simulator” subsection of the QuickSim II User's Manual.
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QuickSim II Session Window

• Contains all QuickSim II windows and supports 
interaction

• Displayed when QuickSim II invokes unless -
NODisplay switch is used

• Provides task-based palettes, menus, strokes, and 
function (soft) key labels
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QuickSim II Session Window
The session window is a userware frame that contains all other QuickSim II 
subwindows within it and controls the interaction between the data in those 
subwindows. When you invoke the QuickSim II simulator, it displays a default 
window called the session window. The session window contains the following:

• Window menu button. Contains a popup menu for session window control

• Title area. Displays the application title and design path

• Minimize/maximize buttons. Makes the window into an icon or full size

• Pulldown menu bar. Contains pulldown menus in specific categories

• Palette. Contains task-oriented icons and buttons that you can click on to 
easily perform the associated task.

• Session popup menu. Contains menu items common to subwindow popups

• Soft key labels. Context-sensitive labels that identify the purposes of the 
function keys

• Message area. Displays important information in a one-line format

When invoking QuickSim II, you can use a -Setup switch to restore setup 
conditions that you had previously saved. You can also use a -Nodisplay switch if 
you do not want QuickSim II to display the session window at all.

Six palettes are available, which you can choose by clicking on the buttons at the 
top of the palette. The palette icons are organized according to whether you are 
setting up, defining stimulus, editing waveforms, changing the design, debugging 
gate-level models, or debugging VHDL models.

i For more information about the session window, refer to the “A Session 
Window” subsection of Getting Started with Falcon Framework.
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Schematic Window

• Contains a schematic sheet

• Provides hierarchical design viewing and access 
to design objects

• Uses the session popup menu

• Highlights back annotations

• Allows back annotations to be hidden or viewed

/:sheet1

COUNT(11:0)

FINISH

START

CLR

ANALOG_OUT
OSC

74LS161A

VCC

VCC

74LS04

U9

74LS74A
U26

VCC

74LS161A

74LS74AU26

VCC

VCC

74LS04

U9

74LS74AU27

VCC

74LS161A

VCC

74LS04

U9

74LS27

U21

74LS27

U21

74LS11

U13

74LS08

U12

RCO

_CLR
_LOAD
ENT
ENP

CLK

QA
QB
QC
QD

A
B
C
D

0

1

2

3

_P
R

E
4

CLK3

_Q 6

Q 5D2

_C
L

R
1

RCO

_CLR
_LOAD
ENT
ENP

CLK

QA
QB
QC
QD

A
B
C
D

10

11

8

912

13

6

4

5

7

4

3

6

52

1

RCO

_CLR
_LOAD
ENT
ENP

CLK

QA
QB
QC
QD

A
B
C
D 11

10

9

8

12

1

3

108

6

119

12

4

4

3

5

2

1

13

5

12

6

13

3

_P
R

E

CLK

_Q

QD

_C
L

R

_P
R

E

CLK

_Q

QD

_C
L

R



Some Basic Concepts

Getting Started with QuickSim II, V8.5_1 2-23
November 1995

Schematic Window
Inside the session window, you can add a subwindow called the schematic view 
window that contains a schematic sheet. This window enables you to view the 
design hierarchically. You can graphically select and unselect design objects in 
the schematic view window.

The schematic view window is accessed from within the session window through 
the (Menu Bar) > File > Open Sheet pulldown menu item.

The popup menu available in the Schematic window is the same as the one 
available in the session window.

Back annotations appear in the schematic view window and are highlighted; they 
can also be hidden from view.

i For more information about Schematic windows, refer to subsection 
“Schematic Windows” in the SimView Common Simulation User's 
Manual.
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List Window

• Contains a tabular listing of signal, bus, and 
expression values

• Can be one of several List windows

• Allows selection of individual signals, buses, and 
expressions

• Contains a popup menu item to view signals at a 
specific time
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List Window
Inside the session window, you can add a subwindow called the List window that 
contains a listing of signal, bus, and expression values. This window enables you 
to view signal activity in tabular form. You can create more than one List window 
at a time.

Some of the actions you can perform in a List window are as follows:

• You can create a blank List window from within the session window by using 
the (Menu Bar) > Setup > Open New Window > List pulldown menu item.

• From within the session window, you can open a List window or add to a List 
window that contains signals by using the (Menu Bar) > Add > Lists 
pulldown menu item.

• You can remove a selected or named signal from the List window by using the 
(session window) > Delete > Lists popup menu item.

• You can select individual signals, buses, or expressions in the List window. 
The simulator highlights the selected object.

• You can move a selected signal within the List window by using the 
(session window) > Edit > Move popup menu item.

The List popup menu enables you to view the listed objects at specific times.

i For more information about List windows, refer to subsection “List 
Windows” in the SimView Common Simulation User's Manual.
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Trace Window

• Contains a waveform display of signal and 
expression values

• Shows signal state and strength with line color, 
style, and position

• Can be one of several Trace windows

• Allows selection of individual signals and buses

• Allows selection of waveforms by selecting the 
associated signal name
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Trace Window
Inside the session window, you can add a subwindow called the Trace window 
that contains a waveform display of signal, bus, and expression values. You can 
also view stimulus in the Trace window before running a simulation. This window 
uses line color, style, and position to show signal states and strengths. You can 
create more than one Trace window at a time.

Some of the actions you can perform in a Trace window are as follows:

• You can create a blank Trace window from within the session window by 
using the (Menu Bar) > Setup > Open New Window > Trace pulldown 
menu item.

• You can open or add signals to a Trace window by using the (Menu Bar) > 
Add > Traces pulldown menu item.

• You can remove a selected or named signal from the Trace window by using 
the (session window) > Edit > Delete popup menu item.

• You can move a selected signal within the Trace window by using the 
(session window) > Edit > Move popup menu item.

• You can select and highlight signals and buses in the Trace window. You can 
also select waveforms by selecting the associated signal name.

• You can add cursors to show signal levels and strengths at specific times. You 
can also add multiple cursors to show time differences.

i For more information about Trace windows, refer to subsection “Trace 
Windows” in the SimView Common Simulation User's Manual.
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Monitor Window

• Contains values of signals and expressions at 
current time

• Can be one of several Monitor windows

• Allows selection of individual design objects and 
buses

• Uses the session popup menu

Monitor

Time(ns)

65000.0

/count(3)

0

/count(5)

1

/count(2)

0

/count(4)

0



Some Basic Concepts

Getting Started with QuickSim II, V8.5_1 2-29
November 1995

Monitor Window
Inside the session window, you can add a subwindow called the Monitor window 
that displays signal and expression values at the current time. You can create more 
than one Monitor window at a time.

Some of the actions you can perform in a Monitor window are as follows:

• You can create a blank Monitor window from within the session window by 
using the (Menu Bar) > Setup > Open New Window > Monitor pulldown 
menu item.

• You can open or add signals to a Monitor window by using the (Menu Bar) > 
Add > Monitors pulldown menu item.

• You can remove a selected or named signal from the Monitor window by using 
the (session window) > Edit > Delete popup menu item.

• You can move a selected signal within the Monitor window by using the 
(session window) > Edit > Move popup menu item.

• You can select individual design objects and buses in the Monitor window. 
The simulator highlights the textual object.

The popup menu available in the Monitor window is the same as the one available 
in the session window.

i For more information about Monitor windows, refer to subsection 
“Monitor Windows” in the SimView Common Simulation User's 
Manual.
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Waveform DBs Window

• Lists in-memory WDBs and indicates which one is 
the default

• Allows selection of a WDB by clicking on a WDB 
name
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Waveform DBs Window
Inside the session window, you can add a subwindow called the Waveform DBs 
window, which lists all of the waveform databases (WDBs) currently in memory.

Next to the list of WDB names is an indicator of the default status of each WDB. 
The default WDB is indicated by an entry of T (true), whereas each of the other 
WDBs are indicated by an entry of F (false). The default WDB provides signal 
data to the window displays.

You can create a Waveform DBs window from within the session window by 
using the (Menu Bar) > Report > Waveform DBs pulldown menu item.

i For more information about waveform databases (WDBs), refer to 
subsection “Waveform Databases” in the SimView Common Simulation 
User's Manual.
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Waveform Window

• Lists the waveforms for the specified waveform 
database (WDB)
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Waveform Window
Inside the session window, you can add a subwindow called the waveform 
window that lists all of the waveforms for a specified waveform database (WDB). 
The title bar of the window indicates the name of the WDB for which the 
waveforms are listed. Each waveform listing indicates the name of the WDB as 
well as the name of the waveform.

Some of the actions you can perform in a waveform window are as follows:

• You can select individual waveforms in the waveform window by clicking on 
the name of the waveform.

• You can create a waveform window from within the session window by using 
the (Menu Bar) > Report > Waveforms pulldown menu item.

The simulator displays a dialog box where you can select the WDB in which 
you are interested.

• You can also select the Waveform Database in the Waveform DBs window 
and choose the Report Waveforms menu item from the popup menu.

i For more information about waveforms, refer to the SimView Common 
Simulation User's Manual.
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QuickSim II Palettes

• Organized by task (setup, stimulus, debug)

• Contain buttons and icons

• Buttons are unchanging; icons are palette 
sensitive
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QuickSim II Palettes
The simulator provides six palettes that are organized according to simulation 
tasks. The palettes, which contain buttons and icons that you can click on for easy 
command entry, appear on the right side of the session window. The elements that 
make up a palette are as follows:

• Palette title. Indicates the name of the displayed palette.

• Palette display buttons. Allow you to display the desired palette by clicking 
on the associated button. These buttons are available regardless of which 
palette is selected.

• Common command buttons. Allow you to issue commonly performed 
commands by clicking on the associated button. These buttons are available 
regardless of which palette is displayed.

• Palette icons. Allow you to perform commonly performed tasks by clicking on 
the associated icon. These icons are specific to the palette that is displayed.

i For more information about palettes, refer to the Help > Palettes 
pulldown menu items.
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QuickSim II Pulldown Menus

• Are available in the session window menu bar

• Use some categories unique to QuickSim II

• Contain categories: MGC, File, Edit, Add, Delete, 
WDB, Setup, View, Report, Run, and Help
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QuickSim II Pulldown Menus
The pulldown menus are attached to the menu bar of the session window. The 
categories of menus available in the menu bar are as follows:

• MGC. Items for executing common Mentor Graphics window commands

• File. Items for opening, saving, and restoring design information

• Edit. Items for selecting/unselecting and editing objects and properties

• Add. Items for adding windows and objects

• Delete. Items for deleting objects and definitions

• Setup. Items for setting up the windows and QuickSim II environment

• Run. Items for controlling simulation runs

• Report. Items for reporting information on different design objects

• View. Items for controlling the view in a window

• Help. Items for obtaining information about commands and the user interface

You access a pulldown menu by placing the pointer on the menu category in the 
menu bar and pressing the Menu mouse button.

i For more information about simulation pulldown menus, refer to the 
SimView Common Simulation User's Manual.
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QuickSim II Popup Menus

• Are available within all windows

• Are unique to QuickSim II

• General categories are: Open, Add, Delete, Force, 
Report, Run, Edit, Select, Unselect, and Setup

• Different windows can have different popup 
menus
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QuickSim II Popup Menus
A popup menu is a menu attached to the main body of any window. There is a 
popup menu available within each subwindow in the QuickSim II session 
window, and is unique to QuickSim II. Popup menus are set up in three ways:

• Some subwindows use the same popup menu as the one in the session window.

Examples of windows that use the session popup menu are: Back Annotation, 
Monitor, schematic view, and Waveform DB Filters.

• Other popups share the same items as the session window popup menu, except 
that additional, unique items for that window are below a separator line.

Examples of windows that share the session popup menu items and have 
unique items below a separator line are: List, Trace, and VHDL View.

• Still other popup menus are totally different from most other popup menus in 
QuickSim II.

Examples of windows that have unique popup menus are: Breakpoints, Keeps, 
Waveform DBs, and waveforms.

You access a popup menu by pressing the Menu mouse button anywhere in the 
main body of a window. You pull the cursor down through the menu to highlight 
the item you want, and then you release the button.

i For more information about simulation popup menus, refer to section 
“Menus” in the SimView Common Simulation User's Manual.
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What Was Covered
By reading the “Some Basic Concepts” section of this training workbook, you 
reviewed or became familiar with:

• The definition of an electronic design

• Models and properties

• Design changes

• Definitions of logic values and drive strengths

• Timing modes

• Waveform databases (WDBs)

• Forces

• Resetting a simulation

• The session window and basic QuickSim II windows

• Palettes

• Pulldown and popup menus
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Module 3
Lab Exercises

Objectives
The following is a list of tasks that you are asked to complete in this lab exercise:

• Invoke QuickSim II from the Design Manager Tools window

• Use the QuickSim II pulldown and popup menus and windows

• Set up the QuickSim II kernel

• Apply stimulus to the inputs of the circuit

• Run the simulator on the circuit

• Use the Trace window to analyze simulation results

• Modify design properties and observe the results of the modifications

• Exit QuickSim II
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Lab Exercise 1: Using QuickSim II

Introduction

This lab exercise shows you how to use QuickSim II to simulate a digital logic 
design created with the Design Architect. It takes you through basic simulation 
operations, such as:

• Invoking QuickSim II

• Setting Up the Simulator

• Applying Stimulus

• Running the Simulator

• Making Design Modifications

Prerequisites

This lab exercise assumes that you are logged in at a workstation licensed to use 
QuickSim II. Also, you need to have a directory into which temporary files can be 
written during some of the procedures.

You must be able to operate within the Design Manager, the graphics-based 
system that manages Mentor Graphics design data. For introductory concepts and 
exercises for the Design Manager, refer to Getting Started with Falcon 
Framework. 

Installing the Training Package

The design data for the lab exercises is named qsim851ng. It is located in a 
software training package named:

qsimng

Before you can perform the lab exercises, this software training package must be 
installed in your Mentor Graphics tree.
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To check whether the qsimng training package is installed, list the contents of the 
$MGC_HOME/shared/training directory by issuing the following operating 
system command:

/bin/ls $MGC_HOME/shared/training

If qsim851ng does not appear in the displayed list, then either you, your instructor, 
or your system administrator must install the “qsimng” software training package.

Setting Up the Lab Exercise

The data for the lab exercises consists of a circuit, library parts, and userware 
(called dofiles). Because you will modify some of the data during the lab 
exercises, you need to have your own local copy.

Use the following procedure to make a local copy of the lab exercise data:

1. Invoke the Design Manager by entering the following command at the shell:

$MGC_HOME/bin/dmgr

When it invokes, the Design Manager displays the Tools window on the left 
and the iconic navigator window on the right, as shown in Figure 3-1.
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Figure 3-1. Design Manager Session Window

You can adjust this window to whatever size is most comfortable. You can 
adjust it in the manner that is typical for your environment, such as by clicking 
on one of the corners and stretching it to the desired position. You can also 
click on the Maximize button, which is at the top-right of the window, to 
increase the size of this window to the maximum that is allowed.
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2. Navigate to the tutorial data by performing the following steps:

a. Click on the “Go To” button shown below:
�������������������

�
�
�
�
�
�
�
�
�
�

b. In the “Change directory to:” field of the resulting dialog box, enter the 
following:

$MGC_HOME/shared/training

c. Click on the OK button to issue the dialog box.

The Design Manager displays icons that represent the contents of the 
training directory. All of these icons are link icons.

3. Click on the icon that is labeled “qsim851ng” to select it.

The Design Manager highlights the icon to indicate that it is selected.

4. Choose the following popup menu path:

(iconic navigator) > Edit > Copy

The Design Manager displays the COPy OBject prompt bar near the bottom of 
the session window.

5. In the Destination field of the prompt bar, specify the pathname where you 
want your local copy. For example: $HOME/training/qsim_g or /tmp/qsim_g.

For the remainder of the tutorial, the pathname that you specify in this step is 
referred to as your_path.

6. Click on the OK button to issue the prompt bar.

The Design Manager copies the design data for the tutorial to your local area. 
Because the tutorial design data includes the library parts, this procedure takes 
a short while. When the operation is complete, the Design Manager displays 
the following in the message area at the bottom of the session window:

The Copy operation was successful.
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Invoking QuickSim II

The first procedure in using QuickSim II is to invoke it on the design. After a 
design is captured, you can move directly into simulation. Preprocessing of most 
designs is not necessary, although designs that require special configurations must 
be processed with the Design Viewpoint Editor (DVE) before being simulated. 
For information about when and how to use DVE, refer to the Design Viewpoint 
Editor User's and Reference Manual. 

To invoke QuickSim II on the FREQ_DET circuit from within the Design 
Manager, follow these steps:

1. Navigate to your copy of the tutorial design data by performing the following 
steps:

a. Click on the following “Go To” navigator button:
�������������������
�������������������

�
�
�
�
�
�
�
�
�
�

b. In the Change directory to: field of the resulting dialog box, enter the 
pathname of your_path.

c. Click on the OK button to issue the dialog box.

The Design Manager displays the icons that represent your copy of the 
tutorial design data.

2. Click on the component icon that is labeled “freq_det” to select it.

3. Invoke QuickSim II by choosing the following popup menu path.

(iconic navigator) > Open > QuickSimII

The Design Manager creates a new window for the QuickSim II application to 
invoke in.

4. (Optional) To clear the screen while leaving the window invoked, minimize 
the Design Manager session window.
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As the simulator invokes on the FREQ_DET circuit, it automatically creates an in-
memory design viewpoint, since a design viewpoint did not already exist. Part of 
this design viewpoint is a set of default configuration rules, which the simulator 
uses to evaluate the design. Design evaluation consists of determining the 
connectivity of the design, the instances that are primitives, and the properties that 
are visible.

�����
�����
�����

Note

During these lab exercises, you may see the simulator display some 
Warning messages that cite outdated reference information and 
unchecked sheets. These messages occur because QuickSim II 
recognizes that the design is an unverified copy of the original. 
Typically, you would perform some verification of the design data, but 
in this case, the design data has been configured so that verification is 
not necessary. You can ignore these warning messages.

Setting Up the Simulator

The setup for the simulator determines how it behaves and how it displays the 
simulation results. This lab exercise assumes you are using the defaults for the 
session setup.

In addition to setting up the session, you can set up the user interface and the 
QuickSim II kernel. The following subsection reviews the QuickSim II session 
window, and then further subsections describe how to set up for a simulation.

The Session Window

When the simulator invokes, the QuickSim II session window appears, as shown 
in the QuickSim II Session Window figure on page 2-20.

NOTE: Several config file errors are reported in an Info Messages window. These 
are BLM compilation errors and are not critical to this Lab Exercise.

The session window is your gateway to the QuickSim II simulator. The following 
list describes features of the session window.

• Window menu button or window menu. Displays a pulldown menu that 
enables you to manipulate the session window. From this menu, you can move 
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the session window, change its size, restore it to a previous size, minimize or 
maximize it, or close it.

• Title bar. Displays the title of the window or other useful information, such as 
a pathname.

• Pulldown menu bar. Displays different menu names as you activate different 
windows. The menu bar appears in session windows only.

• Palette. Sets of task-oriented icons and buttons that you can click on to easily 
perform the associated task.

• Minimize button. Turns the window into an icon

• Maximize button. Increases the size of the active window to its maximum 
allowable size or returns the active window to its previous size.

• Session window body. Provides a backdrop for all the simulation windows, 
pulldown and popup menus, dialog boxes, and prompt bars that are displayed 
during a simulation session.

• Message area. Provides information, warnings, or errors about simulator 
actions during an operation.

QuickSim II Windows

To examine simulation results, you need to create windows inside the session 
window. Although QuickSim II generates many windows, depending on the 
category of information requested, a set of general-purpose windows is as follows:

• Schematic view window. Displays a schematic of the design you are 
simulating

• Trace window. Displays waveforms of signal activity

• List window. Displays a tabular listing of signal activity

• Monitor window. Displays the current values of signals

The following subsections show you how to create these windows.
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Creating a Schematic Window

The schematic view window displays the schematic of the design. The following 
steps explain how to create and use the schematic view window:

1. To create a schematic view window, click on the following palette icon (icons 
are in the bottom half of the palette):

[Setup] Open Sheet

The simulator then displays the schematic view window containing the 
schematic for FREQ_DET, which is shown in Figure 3-2. The name of the 
schematic appears in the lower right corner of the schematic border.

Note that, like the session window, it has a window menu button and maximize 
and minimize buttons. Along the bottom and right-hand borders are scroll bars, 
which show you your relative position in the window and allow you to change 
that position.
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Figure 3-2. Schematic Window
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2. Activate the schematic view popup menu by placing the pointer in the 
schematic view window and pressing the Menu mouse button.

The schematic view popup menu is almost identical to the session popup 
menu. The only difference appears below a separator line near the bottom, 
where a category of View tasks are available.

3. View an area of the schematic by performing the following steps:

a. Choose the following popup menu path:

(schematic view) > View > Area

The simulator displays the VIEw ARea prompt bar near the bottom of the 
session window. The prompt bar expects you to specify the area to be 
viewed, which can be any area of the schematic.

b. Position the pointer anywhere within the schematic view window.

c. Press and hold the Select mouse button.

d. Drag the mouse to create a dynamic rectangle that surrounds the area you 
want to view.

e. Release the Select mouse button.

The simulator increases the resolution of the schematic view window to 
match the dynamic rectangle. Increasing the resolution of a window is 
usually referred to as “zooming in”.

4. Use the default action for viewing by choosing the following menu path:

(schematic view) > View

The simulator displays the same prompt bar as it did in the previous step. The 
default action for viewing is to view an area.

Although the View menu item has a cascading submenu (indicated by the 
adjacent arrowhead in the menu), it also has a default action. If you choose the 
View menu item but not the cascading submenu, the default action is to view 
an area. The result is identical to the previous step when you used the entire 
path. Note that any menu item that can be chosen like this has a default action.
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5. Specify another area of the schematic view window using a dynamic rectangle.

6. View the entire schematic by choosing the following popup menu path:

(schematic view) > View > All

The simulator decreases the resolution of the schematic view window so that 
you can view all the graphical objects. Decreasing the resolution of a window 
is usually referred to as “zooming out”.

7. Select the signals to be analyzed by performing the following steps:

a. To see the primary input signals, which are named CLR, OSC, and 
ANALOG_OUT, zoom in on the left side of the schematic using the 
following popup menu path:

(schematic view) > View (> Area)

The simulator displays a prompt bar and waits for you to specify a dynamic 
rectangle.

b. Specify the dynamic rectangle so you can clearly see the names of the 
primary input signals on the left side of the schematic.

c. Select the CLR signal by positioning the pointer over the CLR net, as 
shown in Figure 3-3, and clicking the Select mouse button.
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Figure 3-3. Selecting A Signal

When selected, the entire net should highlight (in white on color monitors) 
and should become a dashed line.

d. Select the OSC and ANALOG_OUT signals in a similar manner.

e. Using the horizontal scroll bar at the bottom of the schematic view window, 
scroll to the right and locate the START, LATCH, and PULSE primary 
output signals.

f. Position the mouse pointer above and to the right of the START signal.

g. Press and hold the Select mouse button.

h. Drag the mouse to create a dynamic rectangle similar to the one shown in 
Figure 3-4.
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Figure 3-4. Selecting Signals Using a Dynamic Rectangle

i. Release the Select mouse button.

The START, LATCH, and PULSE signals should highlight to indicate that 
they are selected.

If you accidentally select unwanted signals, you can unselect them by either 
clicking on them one by one, or by including one or more in a dynamic rectangle.

This design is hierarchical. That is, the functional blocks you see in the schematic 
view window are further defined by schematics at a lower level.

8. View another sheet in the design hierarchy by performing the following steps:

a. In the schematic view window, zoom in so you can read the labels of the 
different functional blocks.

b. Position the pointer over the functional block labeled CARD_FREQ and 
select it by clicking the Select Mouse button.
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c. Press the Open Down function key. (Although this key usually maps to 
CTRL-F8 on most keyboards, you can look at the soft key labels at the 
bottom of the session window to verify the correct key mapping).

The simulator displays the lower-level schematic for the CARD_FREQ 
functional block, which is shown in Figure 3-5. (You may have to explicitly 
view the entire schematic to achieve a view similar to that shown in Figure 3-5. 
From here on, you can zoom in or zoom out in the schematic view window to 
match whatever visual resolution that you like. View other sheets in the design 
hierarchy by following these same steps.
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Figure 3-5. Schematic for CARD_FREQ

The CLR, OSC, ANALOG_OUT, and START signals that you selected earlier 
are also highlighted on this schematic, as shown in Figure 3-5.   Signals that 
are selected at other levels in the design hierarchy are highlighted at all levels.

The simulator places each schematic view window in the same location within 
the session window.
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9. Before continuing, position the mouse pointer over the window menu button in 
the schematic view window and choose the following pulldown menu path:

(window menu button) > Pop

Popping a window lets you view the hidden schematic view window that 
contains the FREQ_DET schematic.

10. Verify that all primary input and output signals are still selected.

The setup operations that you perform in the following subsections use the set 
of previously selected signals.

Creating a Trace Window

The Trace window displays waveforms of signal activity. You can create multiple 
Trace windows during a simulation. The following steps explain how to create a 
Trace window and how to add selected signals to it.

1. Create a Trace window and automatically add the selected signals to it by 
clicking on the following common command button in the palette (on color 
monitors, this is one of the blue buttons in the middle of the palette):

[Setup] Trace

The Trace window is drawn along the bottom of the session window and 
should look similar to that shown in Figure 3-6. The ordering of the signals is 
not important in this lab exercise. If you want, you can resize the window using 
the window menu button or the maximize button.
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Trace

Time(ns)
0.0 400.0 300.0 200.0 100.0 

/LATCH

/START

/PULSE

/ANALOG_OUT

/OSC

/CLR

Figure 3-6. The Trace Window

The signal names appear along the left edge of the Trace window. Because the 
signals are selected, the names should be highlighted (in yellow on color 
monitors). Along the bottom of the Trace window are time labels in 100 
nanosecond increments, which are marked by columns of tic marks (+). 
Various line styles and positions make it easy to visually determine signal 
values.

A row of tic marks identifies the logic level of a signal according to the 
following rules:

• A trace drawn through the tic marks: an unknown (X) logic value. 
Unknown logic values can be either 0 or 1, but it is uncertain which they 
are.

• A trace drawn above the tic mark: a high (1) logic value.

• A trace drawn below the tic mark: indicates a low (0) logic value.
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The Trace window indicates the drive strength of a signal as follows:

• A solid line (light blue on color monitors): an S (strong) strength.

• A dashed line (medium blue on color monitors): indicates an R (resistive) 
strength.

• A dotted line (green on color monitors): a Z (high-impedance) strength.

• A bold solid line (yellow on color monitors): an I (indeterminate) strength.

2. Activate the Trace popup menu by following these steps:

a. Place the pointer in the body of the Trace window, and press the Menu 
mouse button.

The Trace popup menu is also similar to the session popup menu. The 
differences are after the separator line at the bottom of the menu where 3 
items specific to the Trace window are labeled View, Cursors and Label 
Interval.

b. Inspect these menus now, although they won't be used until later.

3. Change the time label increments by following these steps:

a. Locate the time labels, which are displayed along the bottom of the Trace 
window. The default is 100 nanosecond increments.

b. Choose the following popup menu path:

(Trace popup menu) > Label Interval > Specified

The simulator displays the SET LAbel Interval prompt bar.

c. Enter the value 500 in the Domain Interval entry box.

d. Click on the OK button.

You should see the time labels in the Trace window change to 500, 1000, 
1500, and so on.
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4. Change the distance between each time label by following these steps:

a. Position the pointer in the Trace window.

b. Press and hold the Shift key while you press and release the Menu mouse 
button.

This action is a short cut that automatically reissues the menu path that was 
most recently executed in the active window. You should see the simulator 
display the Setup Trace Window dialog box.

c. Change the value in the Pixels Interval entry box from 100 to 50. (Be sure 
the value 500 is in the Domain Interval box.)

d. Click on the OK button.

The simulator reduces the distance between time labels by half. This 
reduction applies to the tic marks as well.

As mentioned before, the signal names in the Trace window are highlighted 
because they are selected. Cross-window highlighting refers to how a selected 
item is highlighted in every window in which it appears.

5. Observe cross-window highlighting by following these steps:

a. Click on a signal label in the Trace window.

The signal is unhighlighted, indicating that it is unselected. If you look in 
the schematic view window, it is also unhighlighted there. Almost all 
windows in QuickSim II support some form of cross-window highlighting. 
Although not all windows recognize electrical design items such as nets, 
some recognize waveforms and others recognize time labels.

b. Click on the signal again to add it to the selection set before proceeding to 
the next step.
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Creating a List Window

The List window displays a tabular listing of signal activity. It can display signal 
values in binary, octal, decimal, or hexadecimal, which is the default. You can 
create multiple List windows during a simulation.

To create a List window and automatically add the selected signals to it, follow 
these steps:

1. Make sure the CLR, OSC, ANALOG_OUT, START, LATCH, and PULSE 
signals are selected.

2. Create a List window and automatically add the selected signals to it by 
clicking on the following common command button in the palette:

[Setup] List

The List window is drawn just to the right of the schematic view window and 
should look similar to that shown in Figure 3-7. The ordering of the signals is 
not important in this lab exercise.

List

Time(ns)

0.0 Xr Xr Xr Xr Xr Xr

^/ANALOG_OUT
^/OSC

^/START^/CLR

^/PULSE
^/LATCH

Figure 3-7. The List Window

The signal names appear at the bottom of the List window. The up-arrow (^) 
that accompanies each signal name points to the column that will contain the 
state values for the signal. The initial signal values appear at the top of the List 
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window. If the value of a listed signal changes, the value is highlighted (or 
appears in green on color monitors).

3. Activate the List popup menu by placing the pointer in the body of the List 
window and pressing the Menu mouse button.

Inspect this menu, and notice the View Time item at the bottom. This window-
specific menu item lets you view signal activity at a specified or selected time.

The List window period controls how often the simulator samples the simulation 
data for subsequent display in the List window, which is different than updating 
the display of the List window. By default, the List window display is updated 
after a simulation run. You can control the update frequency of the List window 
display using the Set Update Rate command, which is not part of this exercise.

Note that, by default, an entry is made to the List window data every time a listed 
signal changes value. This is in addition to the data added because of the List 
period setting. This feature can help during your analysis of the simulation 
because you can find out exactly when a signal changed state.

4. Change the period of the List window by following these steps:

a. Choose the following popup menu path:

(List) > Setup > Update Rate

The simulator displays the Update Rate dialog box.

b. Click on the “Period” button.

c. Change the value in the Period entry box from 0 to 500.

d. Click on the “Change” button.

Note that the “Check for changes: Immediately” choice is highlighted, 
which is the default setting. Leave in this mode.

e. Click on the OK button at the bottom of the dialog box.

The simulator will now add a line of data to the List window every 500 user 
time units during the simulation, as well as each time any listed signal 
changes.
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Creating a Monitor Window

The Monitor window displays the current simulation time and the current values 
of the signals it contains. It can display signal values in binary, octal, decimal, or 
hexadecimal. Hexadecimal is the default. You can create multiple Monitor 
windows during a simulation. To create a Monitor window and automatically add 
the selected signals to it, follow these steps:

1. Make sure the CLR, OSC, ANALOG_OUT, START, LATCH, and PULSE 
signals are selected.

2. Choose the following popup menu path:

Add > Monitors > Selected

The default action of this menu path is to add the selected signals to the 
Monitor window. A similar default action exists for adding signals to the Trace 
and List window.

The Monitor window is drawn at the top of the session window and should 
look like that shown in Figure 3-8. The ordering of the signals is not important 
in this lab exercise.

Monitor

Time(ns)

0.0 XrXr Xr Xr Xr Xr

/ANALOG_OUT /OSC /CLR /START /PULSE /LATCH

Figure 3-8. The Monitor Window

3. To activate the Monitor popup menu, place the pointer in the body of the 
Monitor window and press the Menu mouse button.

There are no differences between the Monitor popup menu and the session 
popup menu.

4. Click on some signal labels and observe cross-window highlighting again.

5. Look at and compare the styles of selection highlighting in each window.
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You should notice that text-based windows, such as the List and Monitor 
windows, use reverse video highlighting. Graphics-based windows, such as the 
schematic view and Trace windows, use line style, reverse video, and color.

6. Unselect everything by clicking on the following common command button:

[Setup] Unselect All

Setting Up the QuickSim II Kernel

The simulation kernel performs the actual simulation. It evaluates each instance 
whose inputs change and passes the output to all connected instances. The kernel 
stores the results that the user interface needs for display and analysis, and it 
discards everything else to keep overhead at a minimum.

The kernel setup determines the characteristics and the level of detail of the 
simulation. For example, the kernel setup determines whether the kernel ignores 
or uses technology files, gathers toggle statistics, or checks for spike and 
constraint conditions. You can set up kernel characteristics for the entire design or 
on an instance-by-instance basis.

NOTE: When you invoked the simulator for this lab exercise, the simulator 
established all setup conditions to their default values. To inspect the QuickSim II 
kernel setup, follow these steps:

1. Inspect the Setup Analysis dialog box by performing the following steps:

a. Choose the following pulldown menu path:

(Menu Bar) > Setup > Kernel (> Analysis)

The simulator displays a dialog box titled Setup Analysis, which defines 
setup conditions for the entire design. Near the top of the dialog box, the 
Timing mode buttons provide a quick way to set up the simulator kernel. 
The default button is Current, which maintains the setup conditions that 
were most recently set.

Setup Analysis

OK Reset

ConstraintTiming mode UnitCurrent

Detail of 'Current' timing mode VisibleHidden

Cancel

Delay
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b. Click on the Visible button to see a detailed display of the setup categories 
and their current settings.

You should see the dialog box expand to display all current settings of the 
setup categories. All categories are set to their invocation defaults, which 
maximize runtime performance. Do not change any settings. This dialog 
box is illustrated below:

Setup Analysis

OK Reset

Suppress

Hazard check

Contention check

ConstraintTiming mode UnitCurrent

Detail of 'Delay' timing mode VisibleHidden

Timing mode = typ Delay Scale 1

Constraint mode MessagesState onlyOff

Override

Override

Spike model SuppressX-immediate Override

Cancel

Model messages

Toggle check

Override

Override

Override

Override

Override

Delay

Change...

X

Transport

Spike warnings to display:

c. Inspect the dialog box and then click on the Cancel button at the bottom of 
the dialog box. If you have trouble accessing the control buttons at the 
bottom of the dialog box, repeatedly use the Tab key to advance the active 
cursor one field at a time.

Any instance in the design can have its own setup. To set kernel conditions for an 
instance, you should first view and select the targeted instance, which is on the 
CARD_FREQ schematic.
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2. Set up the kernel conditions for a specific instance by following these steps:

a. Activate the schematic view window that contains the top-level schematic 
by clicking on the schematic view window's title bar.

b. Use the window menu button to pop the schematic view window that 
contains the CARD_FREQ schematic so you can view it.

The targeted instance (the rectangular symbol labeled 74ls161a) is in the 
left half of the schematic, and is shown in Figure 3-9. Note that this 
instance is unique from others on the schematic because “$G5” appears 
above the right corner.

/:sheet1

CLR

ANALOG_OUT

OSC

74LS161A 74LS04

U9

VCC

74LS27

U21

74LS27

U21

74LS11

U13

74LS08

U12

RCO

_CLR
_LOAD
ENT
ENP

CLK

QA
QB
QC
QD

A
B
C
D

VCC
$G5

Figure 3-9. Instance on CARD_FREQ to Set Up

c. Position the graphics pointer as shown in Figure 3-9 and select the targeted 
instance by clicking the Select mouse button.

d. Click on the following palette icon:

[Setup] Constraints
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The simulator displays the Change Constraint Mode dialog box.

e. Click on the Messages button to enable constraint checking and the display 
of constraint violation messages.

f. Click on the OK button at the bottom of the dialog box.

g. Click on the following palette icon:

[Setup] Timing Mode

The simulator displays the Change Timing Mode dialog box.

h. Click on the “Change...” button to reveal the timing mode selection box.

i. Click on the “Full Delays” Typ button to enable all typical timing values 
for this instance, including those in its technology file.

You should now see “Timing Mode= typ” in the dialog box.

j. Click on the OK button to set the timing mode for this instance.

The simulator calculates timing for this instance according to all the typical 
timing values associated with it.

k. Verify the timing by generating a Timing Info Report window for this 
instance by leaving the instance selected and then choosing the following 
pulldown menu item:

(Menu Bar) > Report > Timing...

l. Click on the OK button of the resulting dialog box.

The Timing Info Report window should look similar to that shown in 
Figure 3-10, which does not show signal highlighting.
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Timing Info
Report Timing Info (Scaled) for Instance            of TYPE QP 
Pin Timing Info for Pin QA of PINTYPE OUTPUT
    Scaled RISE Delay: 0 (ns)
    Scaled FALL Delay: 0 (ns)
Pin Timing Info for Pin QB of PINTYPE OUTPUT
    Scaled RISE DELAY: 0 (ns)
    Scaled FALL Delay: 0 (ns)
Pin Timing Info for Pin QC of PINTYPE OUTPUT
    Scaled RISE Delay: 0 (ns)
    Scaled FALL Delay: 0 (ns)
Pin Timing Info for Pin QD of PINTYPE OUTPUT
    Scaled RISE Delay: 0 (ns)
    Scaled FALL Delay: 0 (ns)
Pin Timing Info for Pin RCO of PINTYPE OUTPUT

/I$88/I$62

Figure 3-10. Timing Info Report Window

3. Examine the information in the Timing Info window by activating it and 
scrolling down using the vertical scroll bar.

4. Unselect everything using the default action of the following popup menu 
path:

(schematic view) > Unselect

5. Clean up the contents of the session window by following these steps:

a. Close the schematic view window that contains the CARD_FREQ 
schematic using the window menu button of that schematic view window.

b. Click on the Minimize button in the Timing Info report window to make it 
an icon. It will be used later in the lab exercise.

Applying Stimulus

After you have set up the user interface and the kernel, you must apply stimulus to 
the inputs of the circuit. In this part of the lab exercise, you will use forces for 
stimulus, although other methods are available, such as waveform databases and 
logfiles.
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Using Forces

Forces are individual stimulus applied on a signal-by-signal basis by using menus 
or commands. The simulator translates forces you enter into a waveform database 
(WDB). You can save the WDB for use by future simulations.

You can use forces to set a signal to a specific value at a specific time. For 
example, you can force a signal to 1 at simulation time 255 and have it last for 500 
user time units. The following steps explain how to apply forces to circuit inputs.

1. To apply forces to the OSC signal, follow these steps:

a. Select the OSC signal by clicking on the label in the Trace window.

b. Display the Stimulus palette (click on the brown STIMULUS button at the 
top of the palette), and then click on the following palette icon:

[Stimulus] Add Force

The simulator displays the Force Multiple Values dialog box.

c. Fill in the dialog box as shown in Figure 3-11.

Force Multiple Values

OK Cancel

Force type

Default

Old

Charge

Fixed

Wired

Reset Help

Signal Name

Absolute

Value Time

Value Time

/OSC

0

1

0

400

Value Time

Value Time

0 800

Figure 3-11. Force Multiple Values Dialog Box

d. Click on the OK button to apply these forces to the OSC signal.
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2. To issue the Run command, follow these steps:

a. Position the graphics pointer anywhere inside the session window and type 
the letter “r”.

A popup command line automatically appears to accept your input.

b. Finish entering the following command at the popup command line:

run 1200    (and press the Return key)

 After running for 1200 user time units, the simulator displays the signal 
activity in the Trace and List windows. Both windows show the OSC 
cycling between states at the times specified in the dialog box.

3. To generate repeating clock signals, follow these steps:

a.  Click on the following palette icon:

[Stimulus] Add Clock

The simulator displays the Force a Clock Signal dialog box.

b. Fill in the dialog box as shown in Figure 3-12.

PERIOD

Force Clock

OK Cancel

Force type

Default

Charge

Fixed

Wired

Reset

Times are Absolute

Signal name Period/OSC

Old

Clock should have

Clear old forces

Stop time

Multiple TransitionsSingle Transition

With a Duty Cycle of 25%50%

Clock is active LowHigh

25% Other

500

Figure 3-12. Force Clock Dialog Box
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c. Click on the OK button.

The simulator deletes any existing (old) forces for the OSC signal and 
applies the repeating force.

4. Run the simulator for 8000 user time units, just as you did in step 2.

Observe the Trace and List windows. The OSC signal cycles until the 
simulation stops.

5. Before continuing, unselect everything by clicking on the following command 
button in the palette:

UNSELECT ALL

A dofile that applies stimulus to the entire circuit is part of this lab exercise. 
However, before executing the dofile, you must reset the simulator to time 0.

6. To reset the simulator, follow these steps:

a. Click on the following common command button in the palette

RESET...

The simulator displays the Reset dialog box, which enables you to reset 
three areas of the simulator at one time: the kernel state, the SimView setup, 
and the QuickSim setup. In this lab exercise, you want to reset only the 
kernel state, which is the button at the top of the dialog box.

b. Click on the State button.

You should see the dialog box expand to display a warning that describes 
the effects of resetting the kernel state. Also, a new button labeled 
Save 'results' Waveform DB appears, and it is selected by default. The 
expanded dialog box is shown in Figure 3-13.
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Reset

OK Reset

State

Save 'results' Waveform DB

Setup

This option will reset the current simulation time
back to zero and clear the 'results' Waveform DB.

Viewpoint

Pathname Navigator...

Replace

Cancel

Figure 3-13. Expanded Reset Dialog Box

c. Click on the Save 'results' Waveform DB button to unselect it.

d. Click on the OK button to issue the dialog box.

Notice that the traces and values in the windows are removed.

e. Now delete all the forces from the current simulation time onward by 
clicking on the following palette icon:

[Stimulus] Delete Forces

f. Click on the All signals button.

g. Click on the OK button to issue the dialog box.

The simulator deletes all forces from time 0 onward.
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7. To apply forces to the entire design, run the dofile that contains the stimulus 
for the FREQ_DET design by entering the following command:

dofile  your_path/dofiles/freq_det.stimulus

The dofile initializes the design and applies the stimulus necessary for a 
successful simulation of the FREQ_DET circuit. A short initialization run 
occurs.

Running the Simulator

Now that you have the display set up, the kernel set up, and stimulus applied, you 
are ready to run the simulation. The quickest way to do this is with the Run 
command, which you have used already.

1. To simulate the FREQ_DET circuit, enter the following command:

run 155000

This command runs the simulator for 155,000 user time units (which takes 
about 10 minutes), which is enough for the circuit to perform completely. 
(Note that, by default, each user time unit equals 1 nanosecond.) During the 
simulation, you should see an information message, and the Trace the List 
windows updating. You should also see the simulator create a new window 
titled “Simulation Messages,” which is similar to that shown in Figure 3-14.

Simulation Messages
Minimum pulse width violation at time 64935.1ns, on i
       Simulated: 22.5ns,  Specified 25.0ns
       On pin 'CLK'

Figure 3-14. Simulation Messages Window

This window contains a message about a pulse width violation that occurred 
during the simulation and can help when you analyze the simulation, which is 
the next step.
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Analyzing Simulation Results

The next step in any simulation run is to examine the simulation results that 
appear in the List, Trace, Monitor, and message windows to see whether the 
results conform to your expectations. The following text familiarizes you with the 
function of the FREQ_DET circuit, and then shows you features of the simulator 
that support the analysis phase.

The FREQ_DET circuit is part of an entry door security system. To gain entry to a 
building with this type of security system, a person must present an electronic 
access card. The system reads the code on the card and, if the presenter has access 
privileges, automatically unlocks the door.

This portion of that system identifies the unique access code of the card being 
presented. It then passes that information to a portion that compares the access 
code to the set of allowable codes, and opens the door if access is allowed. The 
purpose of each primary signal in the FREQ_DET circuit is presented in 
Table 3-1.

Table 3-1. Signal Descriptions
Signal Purpose

OSC Provides the clock signal for the circuit

CLR Clears the circuit at the beginning and end of the 
circuit's task

START Signals when the circuit is ready to start interpreting the 
ANALOG_OUT signal

PULSE Controls when the ANALOG_OUT is sampled

LATCH Controls when the ANALOG_OUT is sampled

ANALOG_OUT Provides the access code generated by the card
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The following steps provide instructions in how to use the simulator feature to 
analyze the FREQ_DET circuit.

1. Compare the results in the Trace window with your expected results by 
following these steps:

a. Activate the Trace window.

b. Choose the following menu path:

(Trace) > View > All

The display shows the traces for the entire run and should look similar to 
the traces in Figure 3-15.

Trace

/LATCH

/START

/CLR

/OSC

/ANALOG_OUT

/PULSE

Time(ns)
0.0 110640.0 82980.0 55320.0 27660.0 138300.0 

Figure 3-15. Trace Window Results

The Trace window can show you simulation results in varying degrees of 
detail. You can view the traces from the entire simulation run for a general 
view of the results, or you can zoom in to a specific time to view closely 
spaced transitions.
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c. Zoom in to the Trace window by using the following popup menu path:

(Trace) > View > Zoom In > 2.0

Zooming in increases the horizontal resolution of the Trace window, 
allowing you to see more detail. (In the Trace window, the vertical 
resolution remains unchanged when you zoom in.) You should see the 
transitions that occurred at the beginning of the simulation.

d. To inspect those transitions more closely, use the following menu path:

(Trace) > View > Area

The simulator presents a prompt bar and expects you to draw a dynamic 
rectangle. The pointer indicates the center of two cross hairs. These cross 
hairs indicate the beginning corner of the dynamic rectangle.

e. Draw a narrow dynamic rectangle around the transitions at the beginning of 
the simulation.

f. Choose the following popup menu path:

(Trace) > View > Time > Specified

The simulator displays a prompt bar near the bottom of the session window.

g. Enter 935 in the Time entry box. (This is the end of the init run and the 
beginning of the data run.)

h. Click on the Mode choice stepper until absolute is displayed.

i. Click on the OK button to issue the prompt bar.

j. Scroll the Trace window back to time zero using the scroll bar.

You should be able to see all the transitions more clearly. If you zoom in far 
enough, you can see that several signals were XR when the simulation 
began. (XR signals are unknown, resistive values which are blue, dashed 
lines on color monitors.) You may have to repeatedly zoom in to achieve 
the resolution necessary.
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2. View the schematic that contains instance “/I$88/I$62” (which caused a run-
time violation) by performing the following steps:

a. First, unselect all objects (palette button or F2 function key).

b. Activate and scroll the Simulation Messages window to locate the instance 
pathname /I$88/I$62.

c. Click on the /I$88/I$62 instance pathname to select the instance.

The instance pathname should highlight, indicating that it is selected.

d. View the schematic that contains this instance by choosing the following 
popup menu path:

(Simulation Messages) > Open > Selected

The simulator locates and opens the CARD_FREQ schematic, which 
contains the selected instance. The selected instance is highlighted. This 
feature provides a quick way to locate a graphical design item whose name 
appears in a window.

3. View the traces at the time of the violation by performing the following steps:

a. Uncover the Simulation Messages window by choosing the Pop item from 
the window menu button in the CARD_FREQ schematic view window.

b. Locate the time value 64935.1ns in the Simulation Messages window by 
activating and scrolling the window.

c. Click on the value 64935.1ns to select the time.

The time value should highlight, indicating that it is selected. At the same 
time, the instance pathname should no longer be highlighted.

d. View the traces at the selected time by choosing the following popup menu 
path:

(Trace) > View > Time > Selected

You should see the traces for the selected time near the center of the Trace 
window.
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4. Add a Trace window cursor at a specific time by performing the following 
steps:

a. Display the Debug Gates palette and then click on the following palette 
icon (make sure that the Trace window is activated first):

[Debug Gates] Add Cursor

The simulator displays the ADD CUrsor prompt bar.

b. In the Cursor Name entry box, enter “violation”.

c. In the Location entry box, enter “64935.1”.

d. Click on the OK button to issue the prompt bar.

The simulator adds the cursor at the specified time, although it is out of the 
displayed range of traces.

5. View this Trace window cursor by performing the following steps:

a. Choose the following popup menu:

(Trace) > View > Cursor

The simulator displays the “Specify Cursor to View” dialog box.

b. Click on the “Position of cursor in window?” Right button.

c. Click on the OK button.

The simulator scrolls the Trace window so the specified cursor is just 
beyond the right-most position in the Trace window. The cursor is not in 
the displayed range of traces.

d. Position the mouse pointer in the Trace window and enter the following 
command:

zoom out 2

The simulator decreases the resolution of the Trace window so you can see 
the cursor.
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The cursor is a vertical bar with box-like flags that identify the value of 
each signal in the Trace window. In this case, the flags display only logic 
values (1, 0, or X), so you can assume that the associated signal strengths 
are the default, which is S (strong).    (Trace cursor flags explicitly display 
all other strengths.) At the bottom of the cursor is the cursor's name and the 
simulation time at its location.

6. Select the Trace window cursor by double-clicking on any part of it.

The cursor should highlight (dotted green line), indicating that it is selected.

7. Move the cursor to a different time by performing the following steps:

a. Click on the following palette icon and then place the mouse pointer in the 
Trace window:

[Debug Gates]  Move A Cursor

The simulator displays the Slide/Snap Cursor prompt bar and a movable 
copy of the cursor.

b. Move the pointer horizontally in the Trace window and observe the 
movable vertical indicator with time window.

You should see the movable vertical line track the position of the pointer. 
The time and state change as the pointer moves.

c. Establish the new location of the cursor at time 65000 (or as close as 
resolution allows) by clicking the Select mouse button when the time 
window indicates this time.

d. Cancel the Slide/Snap Cursor prompt bar.

8. View the entire contents of the Trace window by choosing the following menu 
path:

(Trace) > View > All

9. Make the Simulation Messages window an icon by clicking on its minimize 
button.
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Modifying the Design

During a simulation session, you may want to alter your design and then 
immediately simulate the results. In QuickSim II, you can make a design change, 
adjust or re-apply stimulus to the circuit, and run another simulation without 
exiting and re-invoking it.

In this design data, two technology files are registered to one of the components. 
Perform the following steps to bring a new technology file into the simulation:

1. Change the targeted instance's Model property by performing the following 
steps:

a. Select the targeted instance by choosing the following popup menu path:

(schematic view) > Select > By Name

The simulator displays the Select By Name dialog box.

b. In the Name entry box, enter “/I$88/I$62”.

c. Click on the OK button to issue the dialog box.

The simulator selects and highlights the targeted instance, which is on the 
CARD_FREQ schematic.

d. To see the highlighted instance, uncover the CARD_FREQ schematic view 
window by choosing the Pop item from the window menu button in the 
FREQ_DET schematic view window.

e. Display the Design Changes palette and then click on the following palette 
icon:

[Design Changes] Change Property

The simulator displays the dialog box titled Change Properties, which 
contains a list of the properties attached to this instance that you can edit.

f. Click on the entry “model = $G5”.

The simulator highlights the entry “model = $G5” to show that it is 
selected.
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g. Click on the OK button to issue the dialog box.

The simulator displays the Change Property dialog box where you can 
change the value of the Model property.

h. In the Value entry box, change “$G5” to “new_techf”.

i. In the BA Pathname entry box, enter the following pathname if it does not 
already appear:

your_path/freq_det/default

where your_path is the pathname to your copy of “qsim851ng”.

j. Click on the OK button.

The simulator writes the change to the back-annotation object and displays 
the annotated property value on the schematic. The annotated value is 
highlighted (in red on color monitors).

2. Observe the effects in the Trace and List windows.

When you change the value of certain properties, the simulator state is reset 
to 0. This is evident because the contents of the Trace, List, and Monitor 
windows are removed. The same is true for the Simulation Messages window.

3. In the upper right corner of the session window, locate the report icons for the 
Simulation Messages and Timing Info windows.

4. Restore these windows one at a time by positioning the pointer on an icon, 
pressing and holding the Menu mouse button, and choosing the Restore item in 
the resulting pulldown menu.

You should see that the Simulation Messages window is blank. The message it 
contained became invalid when you changed the design.

Also, you should see that the Timing Info window is lined out, which indicates 
that it contains invalid information. A lined out window is one that has 
diagonal lines drawn through it, as shown in Figure 3-16.
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Timing Info
Report Timing Info (Un-evaluated Technology File) f
Technology File timing statements for Technology Fi
fMAX = 25.000000 (MHz) ON CLK(AH)
fMAX = 25.000000 (MHz) ON CLK(AL)
tp = 10.000000 , 20.000000 . 20.000000 (ns) ON _CLR

Invalid Data

Window Update
Button

Figure 3-16. A Lined Out Timing Info Window

5. Click on the Timing Info window's update button, which is a button that looks 
like an arrow and is located to the immediate left of the window's minimize 
button.

The simulator updates the Timing Info window with new data. When you 
changed the Model property to “new_techf”, the simulator brought the new 
technology file into the simulation.

6. Close the Timing Info window.

7. Position the mouse pointer anywhere in the session window and enter the 
following command:

run 155000

Using the same stimulus that you provided for the previous run, the simulator 
repeats the simulation. Notice that the violation that occurred in the initial 
simulation does not occur this time.

To illustrate the fact that a design change was made, the new technology file 
specified a less-restrictive minimum pulse width. As a result, the Simulation 
Messages window remains empty, indicating that the pulse width violation 
reported earlier no longer occurs.
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8. Exit QuickSim II by performing the following steps:

a. Close the Session window by using the window menu button for the 
Session window or by choosing Quit from the window menu.

The simulator displays the Exit QuickSim dialog box, which queries you 
about saving the results, setup, and viewpoint for the simulation.

b. Click on the Without saving button.

c. Click on the OK button at the bottom of the dialog box.

You should see the simulator close the session window. You may also need 
to close the transcript pad in which it invoked.

9. Since you no longer need the Design Manager, position the mouse pointer over 
its window menu button and choose the following pulldown menu path:

(window menu button) > Close      or
(window menu) > Quit
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What Was Covered
By completing the “Lab Exercises” section of this training workbook, you 
reviewed or became familiar with:

• Invoking QuickSim II from the Design Manager Tools window

• Using the QuickSim II pulldown and popup menus and windows

• Setting up the QuickSim II kernel

• Applying stimulus to the inputs of the circuit

• Running the simulator on the circuit

• Using the Trace window to analyze simulation results

• Modifying design properties and observing the results of the modifications

• Exiting from QuickSim II
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Module 4
For Continued Learning...

Mentor Graphics is dedicated to helping customers be successful by offering a 
variety of training products. Training is available in different formats, including 
Getting Started workbooks, Personal Learning Programs, and Instructor-Led 
Workshops. Many training workbooks are available online in INFORM as well as 
in hard copy form. For continued learning, refer to the following products.

Getting Started Workbooks
Getting Started with Falcon Framework 

Getting Started with Design Architect 

Getting Started with System-1076 

Personal Learning Programs
QuickSim II Training Workbook 

Instructor-Led Workshops
To determine the workshops you should attend, consult with your Mentor 
Graphics account manager or application engineer. You may also contact any of 
our training instructors at Mentor Graphics Training Centers.
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Appendix A
Definitions

cap_pin
A pin property that specifies the capacitance of a pin in picofarads.

For more information about properties, refer to the Properties Reference Manual. 

component
A structure that contains the models used to describe the functional, graphical, 
timing, and technology aspects of an electronic design.

For more information about components, refer to “Design Architect in the 
Framework Environment” in Getting Started with Design Architect. 

design object
An object-oriented database object consisting of data and methods to operate on 
that data. Design objects also contain the information that applications need to 
understand that data. The application-specific information allows applications to 
be invoked on a design object.

For more information about design objects, refer to the “Design Object Elements” 
subsection of Getting Started with Falcon Framework. 

design property
In the Mentor Graphics environment, a means of placing information about a 
component into the design database by using the Design Architect application or 
other Mentor Graphics applications. Simulators and layout tools refer to the 
properties for information about the design.

For more information about design properties, refer to the “Property Types” 
subsection of Getting Started with Design Architect and to the Properties 
Reference Manual. 
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design viewpoint
A special design object that contains design configuration rules for evaluating the 
source object along with references to back annotation objects. It is not a copy of 
the component; it is a set of rules used by downstream applications to evaluate the 
component, and a container in which related design information is stored.

For more information about design viewpoints, refer to “Design Viewpoint 
(Conceptual View)” subsection of Getting Started with Design Architect and to 
the Design Viewpoint Editor User's and Reference Manual. 

design viewpoint configuration
Specifies an interpretation of the design to various Mentor Graphics applications. 
After the design is captured with the Design Architect, it must be configured 
before other Mentor Graphics applications can be used. Mentor Graphics 
applications can automatically create default configurations, or you can 
specifically configure your design's variable properties, level of primitiveness, 
visible properties, and design viewpoint substitutions by using the Design 
Viewpoint Editor (DVE).

For more information about design viewpoint configuration, refer to the Design 
Viewpoint Editor User's and Reference Manual. 

navigate
To move about directories and files by using the Design Manager navigator.

For more information about navigating, refer to the “Navigator Components” 
subsection of Getting Started with Falcon Framework. 

object
Any item, such as a component in a schematic. More often, an object refers to a 
design object. See also: design object.

QuickPart
Refer to “QuickPart schematic” and “QuickPart table” entries.

QuickPart Schematic
A modeling method that consists of a schematic sheet that has been processed by 
the QuickPart compiler. QuickPart schematics can use technology files.
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For more information about QuickPart schematics, refer to the QuickPart 
Schematic Model Development Manual. 

QuickPart Table
A modeling method that consists of a compiled ASCII file that resembles a logic 
table. QuickPart tables can use technology files.

For more information about QuickPart tables, refer to the QuickPart Table Model 
Development Manual. 

run setup
A set of parameters that specifies default run conditions.

For more information about run setups, refer to the QuickSim II User's Manual. 

technology file
Compiled information that you create to provide timing structure (such as path 
delays and timing constraints) and technology-dependent data for simulation 
models.

For more information about technology files, refer to the Technology File 
Development Manual. 
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A
About This Training Workbook, vii
Analyze

results, 3-32
Architecture

QuickSim II, 1-6

B
Behavioral Language Models, 1-3
BLMs, see Behavioral Language Models
Buttons

maximize, 2-21, 3-8
minimize, 2-21, 3-8
window menu, 2-21, 3-7

C
cap_pin

defined, A-1
Capture

process, simulation, 1-4
Changes

design, 2-8
design properties, 2-9

Clock signals
repeating, 3-28

Components
defined, A-1
electronic design, 2-5

Cross-window highlighting, 3-18

D
Databases

waveform, 2-14
waveform, forces, 2-15, 2-17
waveform, results, 2-15
waveform, stimulus, 2-15

Design
changes, 2-8
changes, modify, 2-9
properties, modify, 2-9, 3-38

Design changes, 2-8
Design objects

defined, A-1
Design properties

defined, A-1
Design Viewing and Analysis Support, 1-7
Design Viewpoint Editor, 1-7, 1-9
Design viewpoints, 2-5

automatic, 3-7
configuration, defined, A-2
defined, A-1

Display, 1-9
Distance

time labels, 3-18
Drive strengths, 2-10, 2-11

signals, 3-17
DVAS, see Design Viewing and Analysis 

Support
DVE, see Design Viewpoint Editor
Dynamic rectangles, 3-10

E
Electronic Design Database, 1-7
Electronic designs

components, 2-4, 2-5
design viewpoint, 2-4, 2-5

F
Forces, 2-16

apply, 3-27
WDB, 2-15, 2-16, 2-17

Frequency
update, 3-20

Front end, 1-7
Full timing, 2-13
Functional models, 2-7

H
Highlighting

cross-window, 3-18, 3-21
reverse video, 3-21

I
Increments

time labels, 3-17

INDEX



INDEX [continued]

Getting Started with QuickSim II, V8.5_1Index-2

Index

November 1995

Inputs, 1-8
Invocation, 3-6

K
Kernel

QuickSim II, 1-7
reset, 2-19, 3-29
set up, 3-22

Keyboard, 1-9

L
Linear timing, 2-13

constraints, with, 2-13
List window, 1-9, 2-25, 3-19
Logic level

signals, 3-16
Logic values, 2-10, 2-11

M
Maximize button, 2-21, 3-8
Menu bar

pulldown, 3-8
Menus

paths, ix
popup, 2-21
popup, QuickSim II, 2-39
pulldown, 2-37, 3-8

Message areas, 2-21
Minimize button, 2-21, 3-8
Modelfiles, 1-9
Modeling systems, 1-3
Models, 1-9, 2-6

defined, 2-7
reload, 2-9
swap, 2-9

Modes
timing, 2-12

Modify
design properties, 2-9, 3-38

Monitor window, 2-29, 3-21
Mouse, 1-9

N
Navigate

defined, A-2
Non-functional models, 2-7

O
Objects

defined, A-2
save state, 1-9
setup, 1-9

Outputs, 1-8

P
Page layout, x
Palettes, 2-35, 3-8
Popup menus, 2-21

QuickSim II, 2-39
Process

capture and simulation, 1-4
Properties, 2-6

defined, 2-7
design, modify, 2-9, 3-38

Pulldown menu bar, 3-8
Pulldown menus

QuickSim II, 2-37

Q
QuickPart

schematics, defined, A-2
tables, defined, A-3

QuickSim II
architecture, 1-6
kernel, 1-7
tool set, within, 1-2
userware, 1-7

QuickSim setup
reset, 3-29

R
Rectangles

dynamic, 3-10
Reload

models, 2-9
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Reports, 1-9
Reset

setups, 2-19, 3-29
simulation, 2-18

Results
analyze, 3-32

Results WDB, 2-15
Run

simulation, 3-31
Run setup

defined, A-3

S
Save state objects, 1-9
SC, see Syntax Checker
Schematic window, 2-23, 3-9
Session window, 2-21, 3-7

features, 2-21, 3-7
popup menu, 2-21

Setup
kernel, 3-7, 3-22
simulator, 3-7
user interface, 3-7

Setup objects, 1-9
Signals

clock, repeating, 3-28
drive strengths, 2-11, 3-17
logic level, 3-16

Simulation
process, capture, 1-4
results, analyze, 3-32
run, 3-31

Simulator
setup, 3-7

SimView
reset setup, 2-19, 3-29
userware, 1-7

Stimulus, 3-26
forces, 2-16, 3-27

Stimulus WDB, 2-15
Strengths

drive, 2-11
Swap

models, 2-9
Syntax Checker, 1-7
System-1076, 1-3
Systems

modeling, 1-3

T
Technology files

defined, A-3
Time labels

distance, change, 3-18
increments, 3-17

Timing Info report
window, 3-25

Timing modes, 2-12
full, 2-13
linear, 2-13
linear, with constraints, 2-13
unit delay, 2-13

Title area, 2-21
Title bar, 3-8
Tool set

QuickSim II, within, 1-2
Trace window, 1-9, 2-27, 3-15

U
Unit delay, 2-13
Update frequency, 3-20
User interface

Session window, 2-21, 3-7
Userware

QuickSim II, 1-7
SimView, 1-7

W
Waveform databases, 1-7, 1-9, 2-14

forces, 2-15, 2-17
results, 2-15
stimulus, 2-15

Waveform DBs window, 2-31
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Waveform window, 2-33
WDBs, see Waveform databases
Window menu button, 2-21, 3-7
Windows

List, 1-9, 2-25, 3-19
message area, 2-21, 3-8
Monitor, 2-29, 3-21
QuickSim II, 2-21
Reports, 1-9
Schematic, 2-23, 3-9
Session, 2-21, 3-7
Timing Info report, 3-25
Trace, 1-9, 2-27, 3-15
Waveform, 2-33
Waveform DBs, 2-31


